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Photo-Object Search Interface

Photo-Objects Holidays & Festivities Collection allows you to quickly search for Photo-Object 
images through a simple and interactive interface. 

The interface is divided in two distinct areas: 

The top area is where searches can be issued by entering text that describe the 
images you are looking for, and/or simply selecting a category of interest. When a 
search criteria is entered, the textual description of the corresponding images is 
displayed in a list that can be scrolled. This list gives you the name of the Photo-
Object images found along with a list of keywords that describe them. The first 
keyword in a Photo-Object description corresponds to the category. Additional 
keywords were added to help you find images based on color, texture, material and 
other attributes. When a search is performed, the matching category, letters or words
are highlighted in red, giving you instant feedback on why the displayed items were 
found as a result of the search.

The bottom area displays thumbnails of the Photo-Objects contained in the gallery or 
of the result from the last search performed. The thumbnails can be scrolled by using 
the scrollbar to the right of the thumbnails. The number of thumbnails simultaneously



visible depends on the size of the window and the position of the splitter bar 
separating the top and bottom areas. Moving the splitter up will increase the number 
of visible thumbnails but will reduce the number of visible text descriptions. 

Tips
You can click on a Photo-Object text description to select and make visible its 
corresponding thumbnail, and vice-versa.

Double-click, right-click and drag & drop of a Photo-Object text description has the 
same effect as with a Photo-Object thumbnail.

For more information on searching for Photo-Objects images, click here.



What’s this product about?

Hemera Photo-Objects Holidays & Festivities Collection will help you give your projects an 
edge with revolutionary Photo-Object images. Combining the quality of photos with the 
versatility of clip art, these vividly realistic objects quickly and easily add impact to projects 
on the Web, at home and at the office. Photo-Objects Holidays & Festivities Collection mainly
consists of a large collection of high quality photographic images and a powerful yet simple 
tool to create photo-realistic characters and text.



Photo-Objects Holidays & Festivities Collection

The Photo-Objects application is a revolutionary image search engine that allows you to 
search for a Photo-Object image in a rapid and intuitive fashion. Its interface simultaneously 
displays Photo-Object image thumbnails and their associated name and description. Type in 
keywords that describe the images you are looking for, or simply select image categories 
and Photo-Objects Holidays & Festivities Collection will instantly find the corresponding 
Photo-Object images! In addition, Photo-Objects Holidays & Festivities Collection gives you 
the ability to create PhotoFonts. PhotoFonts are photographic textures that are instantly 
applied to the text you type.

Once you have found the desired Photo-Objects or created PhotoFonts, you can then quickly 
export them to your application using the Export Wizard.

Summary of Functionality:

Quickly and effectively search through thousands of images for use on your web 
pages.

Search images by name, attribute or category.

Create stunning text with PhotoFont Maker that applies photographic textures to the 
text you type. 

Quickly export Photo-Objects or PhotoFonts to your documents.

For more details, see Contents of this online help.



What’s a Photo-Object?

A Photo-Object is a photographic image of a subject without its surrounding background. The
subject has been cut out from the initially rectangular photograph such that it can be placed 
on any background and provide maximum visual impact. 

This image format is similar to other formats sometimes referred to as images with 
Transparency or images that have an associated Mask or Alpha Channel. But unlike typical 
photographic quality image formats that support transparency, Hemera’s Photo-Object 
image format (.HPI) uses little disk space which allows thousands of images to be contained 
on a single CD-ROM. 

Their high quality and resolution allows you to use them for all of your projects. Photo-
Objects are also totally background independent and, using Export Wizard can be inserted 
into almost any application. Photo-Object images that suit your needs can be quickly found 
among our large collection.

Original
photograph

Photo-Object
image

Photo-Object on a
textured

background

Technical Specifications:

Image Size: 600 x 600 pixels (on average)
Number of Colors 
Supported:

16.7 Million (24 bits for RGB)

Transparency Support: 256 Levels (8 bits per pixel alpha 
channel)

Total Image Depth: 32 bits per pixel

What are PhotoFonts?

PhotoFonts are photo-realistic characters or text created by combining text with a bitmap 
texture.

PhotoFonts can be created using PhotoFont Maker.

Technical Specifications:

Image Size: Variable (depends on point size and 
text)

Number of Colors 
Supported:

16.7 Million (24 bits for RGB)

Transparency Support: 256 Levels (8 bits per pixel alpha 
channel)



Total Image Depth: 32 bits per pixel



Contacting Hemera Technologies Inc.

Technical Support 

For online technical support click here.

If you cannot find an answer to your question, or you feel that you have found a 
problem with the application, please contact our technical support staff at 1 819 772 
8200 ext. 4 (09:00 to 4:00, Eastern Standard time) or at the following E-Mail adress:

support@hemera.com

Hemera offers 90 days free technical support from date of first technical 
support contact.

General Enquiries 

For general enquiries, please visit our Web site at http://www.hemera.com.



Searching for a Photo-Object image

Photo-Objects Holidays & Festivities Collection offers several different image search methods
in one simple interface. Searches can be performed in any combination of the following 
methods:

Browsing

Visually identify the image of your choice by scrolling through the Photo-Object thumbnails. 
You can also scroll through the list of Photo-Object names/descriptions. 

NOTE: You can click on a Photo-Object thumbnail to view its corresponding description and 
vice versa.

Search by Category

Select a category by choosing it from the category list. When a category is selected, only 
thumbnails from that category can be browsed. To quickly jump to the next or previous 
category, click on the up or down arrow to the right of the category list box. 

Search by Keyword

Enter keywords that describe the image(s) you are looking for. This allows you to quickly find
the images whose description contains words that match the ones you enter.

When the option Match ALL words (AND) is selected, only the Photo-Objects that contain 
in their description ALL of the keywords you entered can be browsed. When using this 
option, the more keywords you enter, the less Photo-Objects you are likely to get.

When the option Match ANY word (OR) is selected, only the Photo-Objects that contain in 
their description ANY of the keywords your entered can be browsed. When using this option, 
the more keywords you enter, the more Photo-Objects you are likely to get.

A keyword search initially finds words of Photo-Object descriptions that begin with the text 
you enter until a space is entered, which then causes the whole word to be matched, thus 
eliminating words that were partially matched. 

Example: if you enter the text car, the search engine will find all words that begin with car,
such as carrot, carnivore, carving and so on. If you only whant cars (automobiles) to show, 
then follow the keyword with a space. This will show only Photo-Objects which have the word
car in their description.

NOTE: If a category is selected, the keyword search will be performed on that category only.

Where’s the Search button?

Photo-Objects Holidays & Festivities Collection search engine is so fast it doesn’t need a 
Search button. Photo-Object images are searched and displayed as you type the keywords to
be searched or select categories, giving you instant feedback that will save you valuable 
time.

Tips
You can quickly narrow down your searches by entering keywords which correspond 



to attributes of the searched object such as its color, the material it is made of, its 
typical location, etc. For example, to search for a red car you would type: red car 
followed by a space or car red also followed by a space.    The leading space ensures 
that the last word you type is matched with a complete word in a description as 
opposed to matching words that begin with those characters.

To quickly cancel a search and start a new search, click the Clear Search button on 
the toolbar.



Exporting a Photo-Object image to your Document

To export a Photo-Object or a PhotoFont image to your document, e.g. to a wordprocessor, a 
slide presentation, etc., use the Export to  command.



File menu commands

The File menu offers the following commands:

Export to Exports selected Photo-Object or PhotoFont using the 
Export Wizard.

Save As Saves the selected Photo-Object or PhotoFont to the 
specified file format

Exit Exits Photo-Objects Holidays & Festivities Collection.



Edit menu commands

The Edit menu offers the following commands:

Clear Search Clears the current search text and automatically selects < All 
Categories>.

Add Texture... Inserts a new bitmap texture to the PhotoFont texture window.
Delete Texture... Removes selected thumbnail from the PhotoFont texture 

window.
Texture 
Properties...

Edits properties of selected thumbnail from the PhotoFont 
texture window.

Preferences… Changes the default properties for Copy to Clipboard and Drag-
and-Drop.

 Copy to Clipboard Copies the selected image to the Clipboard.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help Topics Offers you an index to topics on which you can get help.
www.hemera.com Goes to the Hemera Technologies Home Page.
Register Product Online Register your Photo-Objects Holidays & Festivities 

Collection through the Internet.
Online Technical Support Goes to the Hemera Technologies Technical Support Web 

page
About Displays the version number of this application.



Clear Search (Edit menu)

Use this command to clear the last Photo-Object search performed. This allows you to 
quickly get rid of the text previously entered for a search and also resets the category list to 
<All Categories>.

Shortcuts
Mouse: Click the Clear Search button  on the tool bar.



Add Texture... (Edit menu)

Use this command to insert a new bitmap texture into the PhotoFont texture window.

Note: Added textures are copied to the Textures folder inside Photo-Objects folder. This 
allows you to freely move or delete your original texture without affecting PhotoFont Maker’s
textures. 

Shortcuts
Mouse: Right-Click in the PhotoFont texture window, then select Add... from the popup

menu.



Delete Texture... (Edit menu)

Use this command to remove a selected texture from the PhotoFont texture window.

Note: When deleting a texture image, only the copy that was made in the Textures folder 
(inside Photo-Objects’ folder) is deleted. If you have the original image elsewhere, that 
original image will not be deleted.

Shortcuts
Mouse: Right-Click the PhotoFont texture you want to remove, then select Delete... in 

the popup menu.



Texture Properties... (Edit menu)

Use this command to edit the properties of the selected PhotoFont texture.

Shortcuts
Mouse: Right-Click the PhotoFont texture for which you want to edit the properties, 

then select Properties... from the popup menu.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Photo-Objects Holidays & Festivities Collection, such as File 
Open.    A check mark appears next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Photo-Objects Holidays & 
Festivities Collection,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Export selected Photo-Object or PhotoFont using the Export Wizard.

Save selected Photo-Object or PhotoFont to any supported file format.

Copy the Photo-Object or PhotoFont to Clipboard for pasting in other applications.

Clear current text and category search.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button and keywords search 
result. A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Photo-Objects window.    To display or hide 
the status bar, use the Status Bar command in the View menu.

The left area of the status bar indicates how many Photo-Objects were found in the last 
search. When no search keywords are present and <All Categories> is selected, this number
represents the total number of Photo-Objects in the gallery. When keywords are entered 
and/or a category is selected, this area displays the number of Photo-Objects found as a 
result of the search.

The right area of the status bar describes actions of menu items and toolbar buttons as you 
move you cursor over them. If after viewing the description of the toolbar button command 
you wish not to execute the command, then release the mouse button while the pointer is 
off the toolbar button.



Help Topics command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Photo-Objects Holidays & Festivities Collection 
and various types of reference information.    

Once you open Help, you can click the Contents tab whenever you want to return to the 
opening screen.



www.hemera.com (Help menu)

Use this command to go to the Hemera Technologies Home Page and keep in touch with 
Hemera’s latest products, news and developments. 

NOTE: You must have a Web browser installed on your system as well as an Internet 
connection for this command to work.



Register Product Online (Help menu)

Use this command to go to the Hemera Technologies software registration Web page and 
register your copy of Photo-Objects Holidays & Festivities Collection.

NOTE: You must have a Web browser installed on your system as well as an Internet 
connection for this command to work.



Online Technical Support (Help menu)

Use this command to go to the Hemera Technologies Technical support Web page 
(http://www.hemera.com/techsupport.html) where you will find answers to the most 
frequently asked questions (FAQ) regarding technical support. If your question is still without 
an answer, send us Email at: support@hemera.com.

For other non technical inquiries, send us Email at: info@hemera.com.

NOTE: You must have a Web browser installed on your system as well as an Internet 
connection for this command to work.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Photo-
Objects Holidays & Festivities Collection.



Context Help command 

Use the Context Help command to obtain help on some portion of Photo-Objects Holidays & 
Festivities Collection.    When you choose the Toolbar's Context Help button, the mouse 
pointer will change to an arrow and question mark.    Then click somewhere in the Photo-
Objects window, such as another Toolbar button.    The Help topic will be shown for the item 
you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Restore button



Scroll bar

Displayed at the right edge of the Photo-Object thumbnail window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the gallery or in the result 
from the last search.    You can use the mouse to scroll to other parts of the document.

To scroll one row of Photo-Object thumbnails at a time, click the up or down arrow of the 
scroll bar.

To scroll one page of Photo-Object thumbnails at a time, click in the gray area above or 
below the scroll box inside the scroll bar.

The scroll bar for the PhotoFont textures works in the same fashion.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.



Minimize command (application Control menu)

Use this command to reduce the Photo-Objects Holidays & Festivities Collection window to 
an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Creating a PhotoFont

PhotoFonts can be created using the PhotoFont Maker. PhotoFont Maker allows you to 
quickly and easily create photo-realistic text.

To create a PhotoFont follow these steps:

1) Choose the PhotoFont tab in Photo-Objects Holidays & Festivities Collection.
2) Type in the text for which you would like to create a PhotoFont.
3) Choose the desired font (any installed Windows True Type font can be used).
4) Choose your font size.
5) Choose the texture you would like to insert into your text from the available 

textures, or add your own textures by dragging and dropping them into the 
PhotoFont textures window. You can also add textures using the Add Texture... 
command.

6) Use the Export to    command to export the PhotoFont.

Tips
If the texture is not positioned the way you would like in respect to your text, try 
resizing the bottom right corner of the PhotoFont window. This will adjust the 
positioning of the texture within the text.

Try using different font sizes when adding your texture to see the effect. Some 
textures may look better in a larger font size. Once finished, the PhotoFont can be 
resized 



PhotoFont Maker Interface

Photo-Objects Holidays & Festivities Collection allows you to quickly create PhotoFont 
images through a simple and interactive interface. 

The interface is divided into two distinct areas: 

The top area is where PhotoFonts can be made. You accomplish this by entering text, 
selecting a font, a style and a point size for which you would like to create a 
PhotoFont. When text is entered, the PhotoFont is created immediately.

The bottom area displays the PhotoFont. 

Tips
You can double-click a PhotoFont to export it.

For more information on creating and using PhotoFont images, click here.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>



Export To…

The Export Wizard makes the process of exporting Photo-Objects and PhotoFonts as simple as possible. 
When you double click on a Photo-Object or PhotoFont the Export Wizard will appear.

This wizard allows you to quickly and easily export a Photo-Object to your favorite application by choosing
one of the following options:

1)    WORDPROCESSOR, spreadsheet or other software into which images can be pasted

Choose this option if you wish to use the Photo-Object in a wordprocessor (i.e. Word, WordPerfect(TM), 
etc) or a spreadsheet (i.e. Excel(TM), Quattro Pro(TM), etc). This is also the best option if you are not 
sure what option to choose or if you have already tried several other options and they did not work.

2) SLIDE PRESENTATION software

Choose this option if you wish to use the Photo-Object in a presentations package. Presentation 
packages vary in the way they handle files.    Click on the arrow and choose the appropriate software from
the drop-down list (PowerPoint®, Presentations(TM), Harvard Graphics® , or Freelance). If the 
presentations package you are using is not found in the list, run a test by choosing one of the other 
packages in the list or try the wordprocessor option.

3)    WEB AUTHORING tool or other software that allows me to build Web pages

Choose this option if you wish to use the Photo-Object on a Web page.

4) GRAPHICS APPLICATION that supports 32 bit images with a transparency mask

Choose this option if you wish to use the Photo-Object in a graphics program and maintain transparency. 
Many graphics programs support transparency in images. This is the first option that you should try when 
working with a graphics application.

5) EXPORT the Photo-Object or PhotoFont to a popular image format

Choose this option if you wish to save the Photo-Object as a file rather than inserting it directly into an 
application. Most popular graphic file formats are supported.



Resize

This step of the Export Wizard allows you to adapt the size and the quality of the object to your needs. 
Resizing the Photo-Object to the right size and resolution before inserting it into your work enables you to 
get the most out of each object, be it for making presentations, building Web pages or simply enhancing 
your text documents.

Manual resize

In this step of the Wizard, the Photo-Object is surrounded by a bounding box with 8 handles in the form of
squares. The Photo-Object can be resized quickly and easily by manually dragging the handles. This is 
similar to the way you would resize an object in a graphics program. As you resize the object, the 
dimensions displayed will automatically change. This allows you to see the exact dimensions of the object
while altering it interactively on the screen.

Entering exact dimensions

You can specify exact dimensions for the Photo-Object by clicking inside the boxes marked “Width” and 
“Height” and then entering the dimensions. Dimensions entered are evaluated in the chosen units of 
measurement. You can also use the arrows to increase or decrease the size of the object.

Units of measurement

There are 3 units of measurement that can be used for resizing objects: pixels, inches and centimeters. 
By clicking on the arrow beside the box marked “Units” you can access the drop-down menu which 
displays these different options. When using the pixels units, the wizard automatically selects the “on-
screen (72 dpi)” resolution for you since those units are mostly useful for on-screen displaying of images. 
For most other uses, selecting physical dimensions such as inches or centimeters along with a resolution 
at which the image are needed is much more useful.

Adjusting image resolution

This list allows you to select the resolution at which you intend to use the image. Selecting the proper 
resolution for your needs allows the wizard to maximize the quality of the image while keeping the file size
and memory usage reasonable. This option is automatically set to “on-screen display (72 dpi)” for you 
when the “Web Authoring Tool” option has been selected in the first page of the wizard.

Resolution Typical Use
on-screen display (72 dpi) Select this item for images that will mostly be 

displayed on a screen, such as in slide 
presentations, web pages or other on-screen 
usage. Images saved using this option can be 
printed but will usually not be of good quality as
they will look fuzzy.

good quality printing (150 dpi) Select this item for images that will be printed, 
such as in text documents or graphics software.
This option provides good quality printing while 
minimizing the image’s file size and memory 
usage. 

high quality printing (200 dpi) Select this item for images that will be printed, 
such as in text documents or graphics software.
This option provides high quality printing of 



images with reasonable file size and memory 
usage. Typically, images saved with this option 
use twice as much memory as with the ‘good 
quality printing’ option but also use half the 
memory that an image saved with the 
‘professional quality printing’ option would.

professional quality printing (300 dpi) Select this item for maximum printing quality, 
such as in documents that need to be sent to a 
professional printing press. This option provides
the best printing quality but also yields the 
largest file size and memory usage, making 
documents potentially harder to work with.

Note that the three above printing resolutions also provide good on-screen display quality. 

What does dpi mean?

The resolution, expressed in dpi (dots per inch) is the number of pixels used to represent 1 inch of image 
information.    A high dpi means greater image detail, especially for printing purposes, but also means 
larger file sizes and memory usage. For example, a 1 inch by 1 inch image at 72 dpi would contain 5,184 
(72x72) pixels, while the same 1 inch by 1 inch image at 300 dpi would contain 90,000 (300x300) pixels.

Photo-Objects are 600x600 pixels on average. This means that when they are used at 72 dpi, the image's
full size is over 8x8 inches (600 / 72 = 8.3). At 150 dpi, those 600x600 pixels make the image 4x4 inches 
(600 / 150 = 4). 

Why isn't my image displaying or printing at the proper size?

The physical dimensions of an image (in inches for instance) is simply a relationship between the number 
of pixels in the image and the dpi value contained in its information header. For example, if a 600x600 
pixel image contains a dpi value of 200 in its header, then a well behaved application using this image 
should display it 3 inches x 3 inches (the application performs the following calculation in each direction: 
600 pixels / 200 pixels per inch = 3 inches). Nevertheless, sometimes the image isn’t displayed at same 
size you had initially set it to when inserted into other documents. This can be caused by the file format 
used to export the image. Some file formats don’t have a placeholder for the dpi in their information 
header. When this happens, the application using the image has no way to perform any calculations that 
would translate to physical dimensions. Another cause for this problem is simply that some applications 
never make any calculation that try to determine the physical dimensions of an image. In any case, 
resizing the image to the proper dimensions in the destination application will usually result in the same 
quality as if it had interpreted its size properly in the first place.

Why is the dpi in the exported image lower than the one I had selected?

When resizing an image, the wizard will only re-sample images up to twice their full size in each direction 
for a particular dpi. This is done automatically to prevent images from losing too much quality due to re-
sampling and also ensures the images don’t become unnecessarily large. When an image is resized to 
larger dimensions than twice its full size, the image is re-sampled to twice its full size and the dpi is then 
lowered to a value that allows the image to be displayed at the physical dimensions that were selected. 
This provides the same image quality as if the image had been completely re-sampled to the desired size 
and dpi but considerably reduces the file size and memory usage required to obtain that quality.



Maintain original aspect ratio

This check box allows you to specify that the image’s original aspect ratio should be maintained during 
resizing. This prevents you from distorting the image’s width to height proportions during the resize 
process.

Use image’s full size

Select this option if you want to see how big the non-resized image would be at the currently selected 
resolution. When this option is turned on, the image’s physical dimensions change when the resolution 
(dpi) is changed because the size calculation has now fixed the number of pixels to what the image 
originally contained and re-interprets the physical size based on the selected resolution. It is good 
practice to select this option first and then evaluate the dimensions of the image (at the needed 
resolution) in regards to the print size you would like to use the image at. As a rule of thumb, you can 
usually use an image up to twice this size without visible loss in the image’s quality. Any size beyond 
twice this full size is likely to produce visible degradation of the image. This option is automatically turned 
off when the image’s size is changed.

Size in Mem

This box displays the size in memory of the currently resized image. This size will also closely match the 
image’s file size if it is saved in a non-compressed file format. Of course, for compressed file formats the 
file size can be significantly smaller than this value. This information is provided such that you can keep 
an eye on the image’s total file size or memory usage, which can be surprisingly high when higher 
resolutions (dpi) are selected.

Horizontal flip and vertical flip

These check boxes allow you to flip the image either vertically or horizontally. By flipping the object, you 
can make it face the direction you would like.

Tips

To avoid images from being resampled, click on “Use image’s full size” , select the desired 
resolution and then export it as is. Doing this ensures that all of the image’s original pixels are left 
untouched. In this situation the resolution selected automatically determines the image’s physical 
dimensions that will be used by other software packages.

To get the most quality out of PhotoFonts when printing them, create them using a point size 
several times larger (about 4 times) than what you need. For example, if you want to add a 
PhotoFont having a point size of 72 to a document that you will be printing at 300 dpi, create it 
using a point size of 280 (about 4 times 72). This will ensure that the image in the PhotoFont has 
lots of detail.



Background Color

This step of the Export Wizard allows you to specify the background color of the document on which the 
image will be placed. This information may be needed for two reasons. First, if the format being used to 
export the image does not support transparency, then it is necessary to create the illusion of transparency
by creating an image background that matches the document background. Secondly, the format being 
used to export the image may support transparency but not support 32-bit masks. It is thus necessary to 
smooth out the image edges (anti-aliasing) for the background color being used.

There are three ways to define the background color of your document.

Color Palette

You will see a color listed in the drop-down list. The default color is white. If your    page background is not
white, then click on the drop down list and choose the appropriate color. If you would like to define the 
color using a color model, click on the color palette button and specify the appropriate values.

Pick Color from Document

This option will allow you to pick the background color from the document you are working on. When you 
click on this button, the cursor will change into an eye dropper. Place the eye dropper over top of your 
open    document and click with the left mouse button. The background color will automatically be chosen 
and it will appear in the window.

Background Image Tile

If you are planning to use a particular image file for your background (for example, a photo of a field of 
sunflowers) then you can select that file using this option. By clicking on the arrow you will obtain a hot-list
of the most recently used files. If the file that you require is not in the list, then simply click on the Select 
button. This will launch an Open file dialog box and allow you to search for the file you require.

Once you have selected a file it will appear as a background in the window behind the image that you are 
working on.



Wordprocessor - Drag-and-Drop or Copy to Clipboard

There are two methods that can be used to insert the image into your document: Drag & Drop and Copy 
to Clipboard. 

To insert the image using drag-and-drop, click on the image and continue holding the left mouse button 
down as you drag the image to the document you are working on. When you release the button, the 
image will be inserted.

Some applications do not support drag and drop. If this is the case, then use the Copy to Clipboard 
function. By clicking on the button, the image will be copied to the clipboard. You can then insert it into 
your document by selecting “Paste” from the Edit menu of the application you are working in. You could 
also use the keyboard shortcut Control V.

As wordprocessors do not support transparent backgrounds, the color defined in the Background Color 
step will be used to create an image background that matches the document. This will give the 
appearance of transparency.



Slide Presentation - Save

Save

Click this button to immediately save the image to the shown path. If the file already exists, you will be 
prompted before it is overwritten. To save the image to a slightly different file name, modify the shown 
path by typing your changes directly into the path box and then clicking Save. To replace a previously 
exported image, select it from the path list and then click Save.

Save As

Click this button to browse for a file or folder to which you want to save the image. 

Insert Picture from File

The Save dialog box at this stage will depend upon the package you selected in the Export Wizard Export
To dialog box. PowerPoint® and Presentations(TM)    will allow you to insert a GIF with transparency. You 
will thus be able to maintain the transparent background of the image. To insert the image into your 
presentation, look under the Insert menu of the presentation package for the command Insert picture from
file. Then select the file you have saved.

Copy to Clipboard

Harvard Graphics®    and Freelance will not    accept an image with transparency. The image should 
therefore be inserted using the Copy to Clipboard function. By clicking on the button, the image will be 
copied to the clipboard. You can then insert it into your document by selecting Paste from the Edit menu 
of the application you are working in. You could also use the keyboard shortcut Control V.

Presentation Packages Other Than Those Specified

If you are using a presentations package that is not in the drop-down list of the Export Wizard Export To 
dialog box, then first try the PowerPoint® or Presentations(TM) option to see if you are able to insert the 
image as a GIF with transparency. If you are unable to import the image, or if it automatically comes into 
the presentation with a white background, then choose one of the other options and insert the image 
using the Copy to Clipboard function.



WEB AUTHORING Tool - Save

Image format

First, select the Internet compatible image format that you would like to use. The options are: GIF, JPEG, 
Interlaced GIF, and Progressive JPEG. All of these formats are compatible with Web browsers. 

The Export Wizard will automatically recommend the best file format based on an analysis of the image. 
As a rule of thumb, JPEG is the best format for Photo-Objects unless an image tile is used for the Web 
page background. If an image tile is used as the background, then the Photo-Object must be saved as a 
GIF.

Save

Click this button to immediately save the image to the shown path. If the file already exists, you will be 
prompted before it is overwritten. To save the image to a slightly different file name, modify the shown 
path by typing your changes directly into the path box and then clicking Save. To replace a previously 
exported image, select it from the path list and then click Save.

Save As

Click this button to browse for a file or folder to which you want to save the image. 

Tip: Images should be saved to your Web page’s image directory, i.e. the directory being used to store all
of the files for your Web page. This is because many Web authoring tools only create a link with the file 
once the image is dragged-and-dropped. The default directory can be changed by simply selecting 
another directory.

Drag-and-Drop

Once you have saved the image, it is very easy to move the image to another folder or insert it into your 
Web page. To move the image to another directory, simply drag the image into the desired folder. It will 
automatically be moved into the new folder.

It is just as easy to insert the image into the Web page you are working on. First, ensure that your Web 
Authoring Tool is open and reduce it in size so that you can see your Web page and the Export Wizard 
window at the same time. Now drag-and-drop your image from the Wizard into the desired Web page. 
Depending on the Web authoring tool, either a link will be established or the file will automatically be 
copied into the appropriate folder and the image will be inserted into the Web page.

To have complete control over the optimization of all of your Web graphics, check out Hemera 
NetGraphics Studio 2 on our Web page.



Graphics Application - Save

This step allows you to save the Photo-Object or PhotoFont in one of several file formats that support 
transparency masks (alpha channels). The drop down list gives you the choice of four different file 
formats to use.

· TIFF (TIF) with Transparency
· TIFF (TIF) with Transparency Packbits Compressed
· Targa (TGA) with Transparency
· SunRaster (RAS) with Transparency

The best file format to use depends entirely on the application in which you wish to use the images. It is 
therefore recommended that you try different file formats with your application to find out which one works
best. As a rule of thumb, the TIFF file format is the most widely accepted.

Save

Click this button to immediately save the image to the shown path. If the file already exists, you will be 
prompted before it is overwritten. To save the image to a slightly different file name, modify the shown 
path by typing your changes directly into the path box and then clicking Save. To replace a previously 
exported image, select it from the path list and then click Save.

Save As

Click this button to browse for a file or folder to which you want to save the image. 

Drag-and-Drop

The image can be dragged-and-dropped from the window directly into the document that you are working 
on. This can be done with or without saving the image first.

To verify whether your graphics application has accepted the image with its transparent background, try 
placing the image over a colored background. If there is a white rectangle visible around the image, then 
transparency has not been preserved. If all you see is the image, then the mask has been imported. If you
find that transparency has not been preserved, then return to the Export Wizard and choose a different 
file format. Try all of the formats to see if there is one that works. If the image does not appear in your 
application after you have attempted a drag-and-drop, or you are unable to open the image file using your
application, then this means that the file format may not be recognized by your application. You should 
therefore try another file format.

If, after trying all of the file formats, you are unable to bring in the images with a transparent background, 
then this means that your application does not support images with transparency masks. If this is the 
case, export your images using the Wordprocessor option. Even though you will not be able to preserve 
the transparent background around the image, Export Wizard will create the illusion of a transparent 
background by allowing you to match the image background with your document background.



Popular File Format - Save

Use the drop-down list to define the file format you would like to export the image in. Over 20 different file 
formats are supported.

Save

Click this button to immediately save the image to the shown path. If the file already exists, you will be 
prompted before it is overwritten. To save the image to a slightly different file name, modify the shown 
path by typing your changes directly into the path box and then clicking Save. To replace a previously 
exported image, select it from the path list and then click Save.

Save As

Click this button to browse for a file or folder to which you want to save the image. 

Drag-and-Drop

Images can be dragged-and-dropped directly from the window into your software, document or file folder. 
You do not have to save the image before dragging-and-dropping it.



Preferences

You can insert Photo-Objects and PhotoFonts into your documents by dragging-and-dropping them or 
copying and pasting them from the Photo-Objects window. When you export in this way, the image will 
automatically be exported in a default image format that you can determine. This format is very important,
because not all formats work with all applications. You may want to adjust the default format depending 
on the application into which the images will be inserted.

By going under the Edit menu and choosing Preferences, you can access the Preferences dialog box. 
This dialog box allows you to change the default options for both Copy to Clipboard and Drag-and-Drop.



Drag-and-Drop Preferences

Many applications let you drag-and-drop images into their documents, and this can be a fast and easy 
way of placing Photo-Objects and PhotoFonts. When an image is dropped into another application it is 
presented to the application in a particular file format. In order for the application to accept it, it has to 
recognize the file format that is being offered. Since different applications may accept different file 
formats, it may be necessary to change the format for drag-and-drop. The Preferences dialog has two 
main options for drag-and-drop.

Standard Windows bitmap

This is the best option to use if you are dragging the images into programs such as wordprocessors, 
spreadsheets, etc. This is the format that is the most widely accepted by applications for drag-and-drop, 
so it will work with the widest number of applications. However,    this format    does not support 
transparency.    This means that a background will automatically appear behind the Photo-Objects and the
PhotoFonts. The Export Options dialog box gives you the option of merging the images with any color of 
background. If you are always placing your images into documents with white backgrounds, then you can 
leave the default background color at white. When you drag-and-drop the images they will automatically    
be given a white background, and so when they are placed in your document it will appear as if there is 
no background at all. The default background color can be chosen from the drop-down list. If the color 
that you need is not in the drop-down list, then click on the Color palette button.

An image in the following format

This option gives you a lot of control over the file format that will be used during drag-and-drop. Using the 
drop-down list you are able to specifiy the exact format that you would like used.
Certain file formats support transparency, such as TIFF and TGA. If you are using an application that will 
accept TIFF or TGA images with transparency when dragged-and-dropped, then these are the best 
options. You would then be able to drag-and-drop images directly from the Photo-Objects window while 
maintaining transparency. The best way to find out if your application supports a particular format is trial-
and-error. Open up a document in your application and try dragging-and-dropping images in different files 
formats from Photo-Objects Holidays & Festivities Collection (just change the file format in the 
Preferences dialog box each time). When you find the file format that works best, set it as the default 
format for drag-and-drop.

Certain file formats do not support transparency and the images will automatically be merged with a 
background. You can specify the color of the background by using the drop-down list or by clicking on the 
Color palette button. By merging a background color identical to the background color of your document, 
the image will appear as if it has a transparent background.

Resize when using drag-and-drop

Resizing your image before placing it in a document can decrease the file size and increase the quality of 
the image.    When the check box - Display the resize window when dropping the image -is turned on, the 
Resize window will appear each time you drag-and-drop an image from Photo-Objects Holidays & 
Festivities Collection. You then have the opportunity to resize the object before it is inserted into your 
document. 



Copy to Clipboard Preferences

Using the clipboard is perhaps the easiest and most universal way to insert Photo-Objects and 
PhotoFonts into your documents. You can simply choose the Photo-Objects thumbnail or the PhotoFont 
and choose Copy under the edit menu, or use the keyboard shortcut Control C. You then open your 
document and choose Paste or use the keyboard shortcut Control V.

The Preferences dialog has two main options for Copy to Clipboard:

Standard Windows bitmap

This is the best option to use if you are copying the images into programs such as wordprocessors, 
spreadsheets, etc. This format    does not support transparency, however.    This means that a background
will automatically appear behind the Photo-Objects and the PhotoFonts. The Preferences dialog box 
gives you the option of merging the images with any color of background. If you are always placing your 
images into documents with white backgrounds, then you can leave the default background color at white.
When you drag-and-drop the images they will automatically    be given a white background, and so when 
they are placed in your document it will appear as if there is no background at all. The default background
color can be chosen from the drop-down list. If the color that you need is not in the drop-down list, then 
click on the Color palette button.

An image in the following format

This option gives you a lot of control over the file format that will be used during copy/paste. Using the 
drop-down list you are able to specifiy the exact format that you would like used.

Certain file formats support transparency, such as TIFF and TGA. If you are using an application that will 
accept TIFF or TGA images with transparency, then these are the best options. You would then be able to
copy/paste images directly from the Photo-Objects window while maintaining transparency. The best way 
to find out if your application supports a particular format is trial-and-error. Open up a document in your 
application and try pasting images in different files formats from Photo-Objects Holidays & Festivities 
Collection (just change the file format in Preferences dialog box each time). When you find the file format 
that works best, set it as the default format for Copy to Clipboard

Certain file formats do not support transparency and the images will automatically be merged with a 
background. You can specify the color of the background by using the drop-down list or by clicking on the 
Color palette button. By merging a background color identical to the background color of your document, 
the image will appear as if it has a transparent background.

Resize when using Copy to Clipboard

Resizing your image before placing it in a document can decrease the file size and increase the quality of 
the image.    When the check box - Display the resize window when dropping the image -is turned on, the 
Resize window will appear each time you drag-and-drop an image from Photo-Objects Holidays & 
Festivities Collection. You then have the opportunity to resize the object before it is inserted into your 
document. 



CD-ROM Drives Preferences

These preferences allow you to configure the CD-ROM drives that are searched when a Photo-Object is 
requested, either by double-clicking on it or using other commands that need to extract the full image.

If you have more than one CD-ROM drive available, then turn on the check mark “Also look for Photo-
Objects in the following location(s)” and use the Add button to add CD-ROM drives that should be used 
when looking for a Photo-Object. Note that you also need to select the folders named HPI when adding a 
CD-ROM location. 

The Change button allows you to change a CD-ROM location while the Remove button removes the 
currently selected location from the list.

If you have more than one CD-ROM configured, Photo-Objects will automatically determine which disks 
are in the different drives and will find the image if it is available.



Copy to Clipboard Command (Edit Menu)

The Copy to Clipboard command copies the selected Photo-Object or PhotoFont to the Clipboard. From 
the Clipboard the image can then be inserted into the document that you are working on using the Paste 
command.



Save As

This dialog box allows you to save the PhotoObject or PhotoFonts to a selected file format.



How to take advantage of the transparency built into Photo-Objects in high-end 
graphics packages.

To take advantage of the transparency of our Photo-Objects in advanced packages such as Photoshop, 
export the images using the "TIFF with transparency" or "Targa with transparency". You can do this in 
many ways, either by saving them to a file using "Save As" in the File menu or using the "Export To..." 
wizard and selecting "GRAPHICS APPLICATION". 

Actually, the quickest and easiest way to bring your images to your design software is to configure your 
Drag & Drop Preferences (in the Edit menu) to "An image file in the following format:" and to select "TIFF 
with Transparency" or    "TGA with Transparency". Using this method, all you need to do is click on the 
image of your choice and drag it into your design software to export it. 

Once the image is in your graphics software,    activating the transparency will depend on the package 
that you are using.

Configuring your Drag & Drop Preferences

Go to the Edit menu of Photo-Objects and select Preferences.
Click on the Drag & Drop tab.
Select the option “An image file in the following format:” with the file format TIFF with Transparency.
Uncheck the option Display the resize window when dropping the image.
Click OK

PhotoShop 4.0 & 5.0 - TIFF with transparency recommended

Drag & drop a Photo-Object in Photoshop

Method A

Go to the Select menu
Choose load selection
In the channel drop-down menu select #1 or Alpha 1 (your mask).
Use Copy/Paste to place the floating object in your PhotoShop document.

Method B

Open the channels palette
Make sure the RGB is selected
Hold the Control key on your keyboard and click on the #4 channel (Alpha 1 in Photoshop 5.0)
Use Copy/Paste to place the transparent object in your PhotoShop document.

Photo-Paint 8 - TGA with transparency recommended

Drag & drop a Photo-Object into Photo-Paint, thereby opening a new canvas (do not drop it into an 
existing canvas) .

Method A



If    you have a TGA with transparency, Use Copy/Paste to place the transparent object in your Photo-
Paint document.

Method B

If you have a TIFF with transparency, go to the mask menu, select load, and then select #1 which is your 
mask. You can now use the Copy/Paste to place the transparent object in your Photo-Paint document.

CorelDraw Version 7.467 and higher – TIFF or TGA with transparency 
recommended

Method A: Use normal drag & drop of images with transparency
Method B: From the File menu, select Import, choose the image, click import, draw the desired image 
size in the CorelDraw document.

NOTE: Versions of CorelDraw earlier than 7.467 will not accept any transparency information.




